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PowerPoint 
Basics

Discover PowerPoint 
basics such as starting a
presentation and navigating
PowerPoint’s new interface.
In this chapter, you learn
about the various elements
of the PowerPoint screen,
and how to get help when
you need it.
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The PowerPoint program provides various views and tools you can use to 
build a presentation that includes both words and graphics. PowerPoint enables
you to accomplish the following tasks to design and build a presentation.

An Introduction 
to PowerPoint

4

Build an Outline
You can type the text for your presentation in the
Outline tab. An icon represents each slide and its title
in the outline. Many slides contain both a topic or slide
title at the top outline level and second level text
representing slide bullet points. These bullets convey
the main points you want to make about each topic.

Choose a Slide Design and Layout
The slide design applies preset design elements such
as colors, background graphics, and text styles to a
slide. The slide layout you apply to a slide determines
what set of information the slide includes; for example,
a Title and Content layout inserts placeholders for a
title and a
bulleted list
or graphic
element,
whereas 
a Title Slide
layout
includes title
and subtitle
placeholders.
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in
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Add Content
You can add content such as text, charts, pictures,
and more to the slide itself in the Slide pane of the
Normal view. You also can insert text boxes that
enable you to add slide text that does not appear 
in the presentation outline.

Work with Masters
Masters enable you to add content that you want to
appear in a particular location on every (or almost
every) slide. This saves you from having to add
repetitive content, such as your company logo, to
each and every slide. You can change the master to
set up the footer in a presentation, for example.
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Format Text
After you enter the text for your presentation, you can
format that text in various ways. You can change the
font, increase the font size, and apply bold or italics
to the text. Note that you can modify each individual
text selection or apply text styles globally using
masters.

Organize Slides
When you have created several slides, you may need
to reorganize them to create the correct sequence for
your presentation. You can reorder slides in the Slide
Sorter view. This view shows slide thumbnails that
you can move, delete, duplicate, or hide.

Font and Size 

    Changer 

to change font and size 

Text Text 

A 
A B 

B
C 

Set Up Your Show
You can add narrations, animations, and transitions to
your slides. Record a narration that plays when you
give your presentation. Animations move an element
onscreen, such as a graphic flying onto the screen
gradually. A transition controls how the content of a
new slide appears onscreen; for example, the slide
can wipe in from the corner of the screen.

Run a Slide Show
After you add the contents, choose the slide design
and layout, and add special effects, you are ready to
run your slide show on your computer’s screen. A set
of tools onscreen helps you control your presentation
and even enables you to make notes on your slides
as you present them.

Show Judges
Show Judges
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You can start PowerPoint from the
Windows Start menu. When you open
PowerPoint, a blank presentation
appears automatically. The blank
presentation is ready for you to add
your presentation contents.

START POWERPOINT

1 From the Windows desktop, click Start.

2 Click All Programs.

Note: If you have recently used PowerPoint, its name
may appear on the initial Start menu. In that case, click
Start, and then click Microsoft Office PowerPoint
2007.

11

33

44

22

Start and Exit PowerPoint

Start and Exit 
PowerPoint

6

3 Click Microsoft Office.

4 Click Microsoft Office PowerPoint
2007.

Note: If you purchased PowerPoint as a stand-alone
product, simply click All Programs, and then click
Microsoft Office PowerPoint 2007.
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A new PowerPoint presentation appears
with a blank slide.

11

22
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Is there a quicker way to open PowerPoint?
You can place a shortcut to PowerPoint on your 
Windows desktop. Double-click that PowerPoint 
shortcut icon to open the program. To create a 
shortcut after you have used PowerPoint a few times:

1 Click Start.

2 Right-click Microsoft Office    PowerPoint 2007.

3 Click Send To.

4 Click Desktop (create shortcut).

 l The Microsoft Office PowerPoint 2007    shortcut icon appears on the desktop.

44

EXIT POWERPOINT

1 Click the Office button ( ).

2 Click Exit PowerPoint.

The program closes and the Windows
desktop reappears.
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PowerPoint offers several views you can display to work on different aspects
of your presentation. You will probably work in Normal view most often to
position and format objects on each slide. You also can enter presentation
text in the Outline tab or add speaker’s notes for each slide. 

Understanding the 
Normal View

8

Slide Pane
This largest center pane in the Normal view 
shows all the slide contents. Work here to 
manipulate various slide elements such as 
graphic objects, text, and animations. 

Slides Tab
Click the Slides tab in the left pane to 
see a thumbnail of each presentation 
slide. You can drag slides in the tab to 
change their order in the presentation.

Outline Tab
You can use this tab to enter text for 
your presentation in a familiar outline 
format. Top-level headings in the 
outline become slide titles, and entries 
at the next level become bulleted lists. 

Notes Pane
The Notes pane appears below 
the Slide pane. You can enter 
speaker notes associated with 
the current slide into this pane.
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In addition to Normal view, you can use Slide
Sorter view to organize slides, Notes Page view to
create detailed speaker notes, and Slide Show view
to display your presentation onscreen. 

Navigation Buttons

Change views by clicking one of these status bar
buttons: Normal view ( ), Slide Sorter view ( ),
and Slide Show view ( ). You also can click icons
on the View tab of the Ribbon to switch views,
including Notes Pages view.

Slide Sorter View
Click the Slide Sorter View icon ( ) to use the best
view for reorganizing your slides or quickly deleting 
or duplicating slides. If you double-click a slide in this
view, PowerPoint changes to Normal view with that
slide displayed in the Slide pane.

Slide Show
Slide Show

Navigate PowerPoint 
Views

PowerPoint offers two different ways to change views to get a
different perspective of your presentation: the View tab on the
Ribbon or three always-available buttons at the right end of the
status bar at the bottom of the application window.

Slide Show View
Slide Show view runs your slide show onscreen. Slides
appear one at a time at full screen size. The slide show
includes a panel of tools for navigating the show, drawing
annotations on the slides, or displaying your speaker
notes. To display this view, you can click the Slide
Show button ( ). To exit this view, you can 
press .

Notes Page View
This view enables you to display each slide and the
speaker notes you have entered as a full page
onscreen — just as the page would look when
printed. You can click the Notes Pages button on the
Ribbon to work with this view. See the section “Work
with Ribbon Groups, Commands, and Galleries” for
more information on using the Ribbon.

PowerPoint Basics
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Rather than the traditional menu/
command/toolbar system, PowerPoint
now features the Ribbon. The Ribbon
gathers related commands on tabs such as
the Slide Show tab. On each tab, similar
commands appear in groups, with the
name of each group appearing along the
bottom of the tab. Commands that you
can execute immediately appear as buttons
or check boxes on the ribbon. You can
access other commands from a gallery or
dialog box.

1 Click the desired tab on the Ribbon.

Note: Sometimes additional contextual tabs appear on
the Ribbon to offer more specific commands.

The commands for the tab appear on
the Ribbon.

2 Click the button or check box for any
command that you can select
immediately.

l If a task pane appears at the right, use
it to finish executing the command,
such as selecting clip art to insert.

44
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Work with Ribbon Groups, Commands, and Galleries

Work with Ribbon Groups, 
Commands, and Galleries

10

3 Click the button for a gallery.

Note: Any button with a down arrow on it (either alone
or at the bottom of a scroll bar) displays a gallery when
you click the button.

4 Click the desired choice in the gallery
that appears.
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What happens if I click on the portion of a
Ribbon button that is above or to the left of
the part that has a down arrow on it?
In such a case, PowerPoint applies that Ribbon
command using the settings you last selected for it.
You choose particular settings for a Ribbon button
by clicking the portion
of the button with
the down arrow.
You can then
choose settings
from the gallery.

5 Click the Dialog Box Launcher ( ) at
the right end of the bar with the group
name.

Note: Any group name bar with a Dialog Box Launcher ( )
on it displays a dialog box when you click the arrow.

6 Click choices as needed in the dialog box
that appears to finish executing the
command.

PowerPoint Basics chapter1

11

How do I learn what a particular Ribbon
button does?
Move the mouse pointer over the button, and by
default a ScreenTip describing the button appears.
By default, you see an enhanced ScreenTip that lists
the button name, any available shortcut key, and a
short description of 
the button in some
cases. Note that
the enhanced
ScreenTip
feature as well
as displaying
ScreenTips
altogether can
be turned off in
the PowerPoint
Options dialog box
(described in Chapter 16). 

ScreenTip

l For some Ribbon commands, you need 
to make a selection on the slide before
choosing the command (and any
subsequent gallery or dialog box choices).

Paste

55

66
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Unlike the menu bar in earlier
PowerPoint versions, the
Ribbon is fairly wide at the top
of the screen. You do not need
to see the Ribbon commands at
all times, so you may want to
hide the Ribbon commands
when you are not using them.
This enables you to see more of
the slide that you are working
with.

1 Double-click a Ribbon tab. 

You also can press + to hide
the Ribbon.

l The Ribbon commands disappear from
the top of the screen, but the tabs
remain visible.

2 Click a Ribbon tab.

The Ribbon commands reappear. 
You can then click the button for the
command you want.

l You can drag the Zoom slider or click
one of the zoom controls to its right to
change the zoom for the current slide. 
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Find and Use KeyTips

Some users are more
comfortable using a keyboard
than a mouse. This may be
especially true for you if you
work on a notebook computer
with a finicky touchpad. If you
prefer, you can use KeyTips, or
keyboard shortcuts, to select
commands on the Ribbon. 

1 Press .

l The KeyTips (shortcut keys) for the
Ribbon tabs and Quick Access toolbar
appear in boxes beside the tabs and
toolbar choices. 

2 Press the shortcut key for the tab you
want to select on the keyboard.

In this example, was pressed to
display the Design tab. 

l The tab appears with its available
shortcut keys identified in boxes. 

Note: To hide the tab shortcut keys, press . 
To hide all shortcut keys, press twice.

3 Press the shortcut key for the
command you want to select.

In this example, was pressed to
display the Colors button. The
command executes or a dialog box
appears so you can finish choosing
command options.

Find and Use 
KeyTips PowerPoint Basics
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The Quick Access toolbar
appears beside the Microsoft
Office Button at the top of the
PowerPoint Screen. You can
click buttons on the Quick
Access Toolbar to execute the
most common commands more
quickly.

1 Click the desired button on the Quick
Access Toolbar.

Note: Use any dialog box or menu of choices that
appears to finish executing the command, or click Cancel
to close the dialog box. Later sections explain how to use
various dialog boxes. 

l If you click the down arrow button
beside the Undo button, a menu of
actions to undo appears.

2 Click the Customize Quick Access
toolbar.

3 Click Show Below the Ribbon.

Clicking More Commands enables
you to add more command buttons. 

33

22
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Using the Quick Access Toolbar

Using the Quick 
Access Toolbar

14

l The Quick Access Toolbar moves below
the Ribbon.

Note: To move the toolbar back to the top of the screen,
repeat steps 1 to 2, and then click Show Above the
Ribbon.
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Notes - 

Resize the Notes Pane

The Notes pane is where you
enter speaker notes. This area
appears just under the Slide pane
in Normal view. You can resize the
Notes pane to make it easier to
enter information into it.

You can print just the notes pages from
your presentation. See Chapter 12 for
more about how to print.

1 Move the mouse pointer over the 
pane divider until the split pointer ( )
appears.

2 Drag downward until the pane
disappears.

If you drag upward, the pane enlarges.

Resize the 
Notes Pane

3 Click the View tab.

4 Click Normal.

l The Notes pane reappears.

PowerPoint Basics
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Microsoft Office PowerPoint Help
brings you help from Microsoft
Office Online or installed Help files
if you have no Internet connection.
You can find answers by browsing a
table of contents or by searching.

1 Click the Help button ( ).

The PowerPoint Help window opens.

2 Click a main topic.

Note: In some instances, after you click the main topic, a
list of subcategories appears. Click the desired
subcategory, and continue to Step 3. 22

33
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PowerPoint  
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PowerPoint  
Help

Using Help

Using 
Help

16

A window with a list of detail topics
appears. 

3 Click a detail topic.
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F1

The detail topic help appears. 

l You can drag the scroll bar downward as
needed to read more of the information. 

4 Click Back ( ).

l The previous Help information reappears. 

Note: After you click , the Forward button ( )
becomes active. Click these buttons to browse in Help. 

5 Type a word or phrase.

6 Click Search.

l The search results appear.

You can display a topic and browse as
described in steps 3 and 4.

7 Click Close ( ) to close the Help
window and finish using Help.

77

55 66

44

PowerPoint Basics chapter1

17

Can I leave the Table of Contents visible in
the PowerPoint Help window?
Yes. Click the Show Table of Contents button ( )
in the Help window toolbar to display a Table of
Contents pane at the
left side of the
window. Click a
main topic (with a
book icon) to list
its detail topics
(represented by
question mark
icons), and then
click a detail topic to
view the help. 

HELP

Is there a shortcut for displaying the Help
task pane?
Yes. Simply press and the PowerPoint Help
window opens.
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